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Cascading Style Sheets FrontPage 2003

A Cascading Style Sheet (CSS) is used to apply consistent style information across single or
multiple Web pages or an entire Web site. A CSS contains style definitions that describe the
styles you want to apply to pages or page elements. Each style definition consists of a selector
followed by the properties and values for that selector.

The following are examples of style definitions defined in a CSS:
H1 { font-size: 18; color: green }
H2 { font-size: 14; color: blue }

In this example, H1 and H2 are selectors that modify the formatting properties of standard
HTML tags. The selectors’ properties and values are contained within the braces { } where
font-size is a property, and 18 or 14 is the value of the font-size property. You can specify
multiple properties for a selector by separating each with a semi-colon (;).

FrontPage primarily deals with two types of CSS—embedded and external—although a third
type, inline is occasionally used:

Embedded cascading style sheet: When you create or modify a style to be used on a single
page, FrontPage creates a cascading style sheet for you. Any style you create for that page is
stored in the embedded style sheet as a class selector.

External cascading style sheet: These are the most useful because they can be attached to
multiple Web pages. You can apply the same styles consistently across an entire Web site. If
you decide to change a style, you need only to make one change—in the external cascading
style sheet—and the pages in your Web site will reflect the change. Typically an external CSS
uses the .css file name extension, such as mystyles.css.

Inline cascading style sheet: Contains user-defined styles that are applied to a single page
element. This type of cascading style sheet is usually created when you add styles using the
Style button on a page element’s Properties dialog box.

Creating an External CSS

The external CSS is the most frequently used because it is the most versatile. By creating and
using an external CSS, the user is able to change, add, and modify styles for an entire Web site
simply by reflecting the change, addition, or modification in the external style sheet.

Follow these instructions to set up an external CSS in FrontPage:

1. From the Start menu, click Microsoft Office FrontPage 2003.
Microsoft FrontPage 2003 will open.

2. From here, you can either open an existing Web that you wish to add an external style
sheet to, or start a new Web that you want to add an external style sheet to.

3. Click File, and then New.
The New task pane will open on the right side of the screen.
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4. Click on More page templates.
The Page Templates window opens.

5. Click on the Style Sheets tab in the Page Templates window to reveal the style sheet
options.

Page Templates |'X|
General | Frames Pages | Style Sheets |
g 8 g
e Arcs Bars Blocks Options
Just add Web task

] & & e

Blueprint: Capsules Downkown Expedition Create a blank cascading style sheet.
5] 8 9§ g
Highuwsay Meon Paoekic Street bl

2

Sweets

Page Templates Style Sheets tab

6. Click on Normal Style Sheet, and then click the OK button.
The Page Templates window closes, and a new blank style sheet opens in FrontPage.

DOCO000: Cascading Style Sheets



(<] Microsoft FrontPage - new_page_1.css
i File Edt Miew Insert Format  Tools  Table Dats  Frames

NI T N -, N i AT T e A REC - W A
i | | B Z U]

[new_page_l.css x

Defaule | Custom

Blank external style sheet

You have successfully created an external style sheet that can be used to apply consistent styles
to Web pages or an entire site. The next step is adding and modifying styles to the style sheet.

Adding and Modifying Styles in an External CSS

After you have created an external style sheet, you need to modify the styles that you want to
use on your Web pages. This is the section where you would define items such as a hierarchy of
headings, body font, bullet points, numbering, and so on. You can create each of these items
using font type, weight, color, size, borders, and so on. The styles that are modified in an
external CSS are called HTML tags. Additionally, you can add new styles to the CSS by
creating new HTML tags and then modifying them.

Follow these steps to modify styles on the external cascading style sheet:

A |

' Shyle,
1. Click on the A Style... ————— button in the Style dialog box on the style sheet
page.

The Style window opens.

Style El

Styles: Paragraph preview

=8

ailink
amvisited
E]
address
body

button || - Characker preview

Fieldset

s — AaBbYyGellj
h3

h4

hs Description

& | Click Modify to create a style for the currently
—|  selected HTML tag.

Lisk: Click Mew to create a new custom skyle,
HTML tags £

Style window
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2. Inthe Styles: list, click on the HTML tag that you want to modify, and then click the
Modify button.
The Modify Style window opens

Note: For instance, if you want to modify first level headings, click h1, for second
level click h2, and so on.

Modify Style 3

Mame {selector): Skwle bype:

= | |

Previgwm

Description

Format Lot | [ concel ]

Modify Style window

3. Click on the Format button to reveal the drop down menu that shows the different
formatting options available (Font, Paragraph, Border, Numbering, or Position). From
this menu, click on the option you wish to modify. For this example, we will modify
Font.

The Font window opens.

Font fgl

Font | Character Spacing |
Font: Fort skyle: Size:
Tahoma A~ 10px A
Tempus Sans ITC o .5in |
Times Mew Roman Zmm =
Times Mew Roman (serif) lem
Trebuchek M3 b ic ¥ |5pt 4
Effects

[Junderline [J5mall caps

[ strikethrough [ all caps

[ owerline [ capitalize

[Celink [ Hidden

[ Mo text decoration
Preview

. AaBbTyGgllj |

[ Ok ] [ Cancel

Font window

4. Choose the font, style, size, color, and any effects you want and then click OK.
The Font window closes.
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Note: If you want to modify other parts of the HTML tag at this point, click on the
Format button in the Modify window to reveal the drop down menu and then click on
the option you wish to modify.

5. When you are finished modifying the HTML tag, click OK twice.
The Modify Style and Style windows close.
You are taken back to the external style sheet page, and your h1 HTML tag appears as
a style.

6. Click on File, and then Save to save the style sheet.

Note: Save the style sheet as a file name you will remember, and include the file
extension .css

[El Microsoft FrontPage - new._page_1.css
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ha

font-family: Trebuchet M3; font-size: 18pt: color: #CCO066; font-weight: bold }
font-family: Trebuchet MS: font-size: 16; color: #CCO066; font-weight: bold )

{
{
hody { font-family: Verdana }
h3 { font-family: Trebuchet MS: font-size: ldpt; color: #CCO066; font-weight: bold }
arlink { color: #990099; font-family: Trebuchet M3 )
arvizited { font-family: Trebuchet MS; color: #CCHE99 }
athover { font-fawily: Trebuchet MS: color: $CCFFEE )

Default | Custom

External Style Sheet with modified styles

Repeat these steps to modify as many of the HTML tags as you wish to apply to your Web
page. In the example above, there are modified HTML tags for h1, h2, body, h3, a:link,
a:visited, and a:hover.

Follow these steps to add a new style to the external style sheet:
L Gl

A

bwle., .

1. Click on the A Style...

page.
The Style window opens.

button in the Style dialog box on the style sheet
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2. Click on the New button in the Style window.
The New Style window opens.
New Style g|
MName (selectar): Style bype:
|emphasis| | |Paragraph vl
Preview
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Format ¥ [ a4 ] [ Cancel

New Style window

3. Type the name of your HTML tag in the Name (selector): area.

4. Click on the Format button to reveal the drop down menu that shows the different
formatting options available (Font, Paragraph, Border, Numbering, or Position). From
this menu, click on the option you wish to modify. For this example, we will modify

Paragraph.
The Paragraph window opens.
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After text: | | e
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After: =

Preview
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Paragraph window

5. Modify the areas of your new HTML tag in the Paragraph window, and click OK.
6. Use the Format button to continue modifying the new HTML tag. When you are
finished click OK in the New Style window.
The New Style window closes.
7. Click OK in the Style window.
The Style window closes, and your new HTML tag is added as a style in the external
CSS.
8. Click on the File menu and then Save to save changes in the style sheet

Microsoft FrontPage - C:\Documents and Settingsibrs B9B\Desktopl\csstestistyles.css

File Edit ‘iew Insert Format Tools Table Data  Frames ‘indow Help
BRA=AN" B RAI= RS A WEEWE N A RN R
4| | B Z U]

dlder List 0 x [Lﬂ ‘Web Site ” indes, hkm® \{styles.css*
) C\Documents and Settingsibrsgoat

- hl font-family: Trebuchet M3: font-size: 18pt: color: #0032
| [ _private horder-bottom-style: double; horder-hottom-width: 3px:

Iﬁlmages .enphasis ! text-align: right; line-height: 150%; margin-left: &5 3
@apply,htm .nunbered { list-style-type: upper-roman }

@create.htm ha { font,—fam:.Lly: Trebuchet MS: font-size: 17; color: #CCOOE
ﬁindex.htm body { fontrfam:.Lly: Verdana }

= a:link { font-family: Verdana; color: #CCO593 )

a}newstyle.css a:wisited { font-family: Verdana; color: #580065 }

Jstylas.css athover { font-family: Verdana: color: #CC33FF }

External style sheet with added and modified styles

Linking an External CSS to a Web Page or Site

Now that you have created an External CSS and added or modified the HTML tags, the next
step is to link the CSS to your Web page or site.

Follow these instructions to link the external CSS to a Web page or Web
site:
1. Open the Web page that you want to link the CSS to.
2. Inthe toolbar, click Format, and then Style Sheet Links.
The Link Style Sheet window opens.
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3. If you want to connect the CSS to all pages in your Web site, click on All pages. If
you want to connect only certain pages to the CSS, click Selected page(s).

4. Click on the Add button.
The Select Style Sheet window opens.

Select Style Sheet

Loak in: ||.iﬁ csstest v| oF EE

Mame Title
|C5) _private

@images

skyles.css

< |
URL: |styles.css Y| g ﬂ

[ Ok ][ Cancel ]

Select Style Sheet window

5. Click on the style sheet you created in the Name area, and then click the OK button.
The Select Style Sheet window closes.

6. Click on the OK button in the Link Style Sheet window.

7. Click Continue in the Confirm Format Style Sheet Links warning window if it appears
to apply the style sheet to your Web.
The Link Style Sheet window closes, and your web page/site is now linked to your
style sheet.

Applying Styles on a Web Page
Once you have created a style sheet, added styles to the CSS, and then linked the CSS to your
document, you can apply the styles to the content on your page.

To apply styles to the content on your page, you will use the style drop down menu on the top
left side of the formatting toolbar:
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1. Click on the text in the Web page that you want to apply a style to. For example, a
level one heading.

2. Click on the Style drop down menu at the top left corner of the screen, and then click
on the HTML tag you want to apply to your selection.
The style is applied to the selected text.

[E] Microsoft FrontPage - new_page _1.htm
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1 Heading 6 How C55 Work

1 Menu List

fyfiornl Cascading style sheets work by applying specified style to Web
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Learn how to create a style sheet.

Learn how to apply a style sheet.

Style drop down menu

3. Continue repeating these steps for any text that you want to apply a HTML tag to from
the style list.

Changing Applied Styles
The best part of using an external CSS is that if you ever need to change a group of HTML tags,
it can be done in a few steps through the CSS rather than manually changing every format in an
entire Web site. Changing an HTML tag is easy, and uses the same steps as modifying an
HTML tag.

Follow these instructions to make changes to styles in an external CSS.
1. Double click the style sheet in the folders list to open the CSS.
Y S |
"'é Skyle. .,

2. Click on the A Style... ———— button in the Style box.
The Style window opens.
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3. Click on the HTML tag you wish to change in the Styles: list, and then click the
Modify button.
Note: The HTML tags may not be in the Styles: list. If this is the case, click on the
List: drop down menu and then click on HTML tags.

The Modify Style window opens.

Modify Style X

Mame (selectar): Style tyvpe:

= || |

Presview

Description

Format ¥ [ Ok l [ Cancel

Modify Style window

4. Click on the Format button to reveal the drop down menu.

5. Click on the element in the Format drop down menu that you wish to change. For this
example we will modify Border.
The Borders and Shading window opens.
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6. Make any changes in the Borders and Shading window, and then click OK twice.
The Borders and Shading and the Modify Style windows close.

7. Continue following steps 1-6 to make necessary changes to HTML tags, and then click
OK in the Style window.
The Style window closes.

8. Click on the File menu, and then Save to save the changes in the CSS.
The Web site or pages will now reflect the changes made to the external cascading
style sheet.

Getting Help
If you need help using cascading style sheets, click on the Help menu in the standard toolbar, or
press F1. Using this resource, you can search for cascading style sheets in the help system to
find answers to questions you may have.

You can also visit Microsoft office online through the Help menu to search the online resource
for FrontPage assistance.
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